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1 Introduction  

 

The name ‘POLYGONALmeister’ includes ‘polygon’ that means a shape which has 

multiple angles. Data that expresses shapes based on collected polygons is referred to as 

‘polygon data’. Polygon data communicated via STL and other types of file formats are 

triangle data in most cases.  

POLYGONALmeister is a software product that enables triangle polygon data to be 

edited and evaluated. 

 

This common operation manual to the POLYGONALmeister series describes 

functions that may not be depending on the license that has been granted through 

contract. 
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2 Terms 

This section explains the terms used in POLYGONALmeister. 

 

2.1  Terms Expressing Shapes 

POLYGONALmeister expresses surface of an object by covering it by triangles. 

Adjacent triangles are arranged to meet the sides and both the vertices thereof. This 

status where sides and vertices are met is referred to as ‘connection’. 

 

◼ Mesh 

A mesh represents a collection of triangles that express shapes.  

 

◼ Shell  

A shell represents a collection of triangles (faces) that are mutually connected in a 

mesh. Connected triangles (faces) belong to the same shell. For example, a mesh that 

has a hollow part (closed cavity) inside consists of a Shell that is recognized externally 

and a shell that represents the surface of the internal hollow. These two shells are not 

connected to each other. Shells include closed shells such as solids and open shells such 

as surfaces. Furthermore, a shell has two sides, an obverse side and a reverse side. 

 

◼ Shell Boundaries 

Shell boundaries represent circumferences of open shells such as external peripheries 

and hole peripheries. 

 

◼ Faces 

A mesh is comprised of shells. Individual shells are comprised of triangle data, faces.  

A face has sides, an obverse side and a reverse side. 
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◼ Edges 

An edge represents a side of a triangle (face). 

 

◼ Vertices 

Vertices represent triangle apexes that are positioned by coordinate values. 

POLYGONALmeister does not use units such as mm to indicate coordinate values.  

 

See below a simple example. 

 

 

 

 

 

 

 

 

 

  

Shell Face

EdgeVertex

Shell Boundary

Mesh

The mesh right consists of  

2 shells,  

2 shell boundaries, 

5 faces, 

12 edges, and 

9 vertices.  
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◼ Obverse Side and Reverse Side of Face 

Faces (triangles) have two distinct sides, obverse and reverse. The obverse side 

represents the side where vertices appear to be positioned counterclockwise. The 

example face figures below show that triangle (face) vertex data are expressed in the 

order of A, B, and C in external files such as STL. The left figure shows the obverse 

surface of the triangle (face) and the right figure shows the reverse surface. 

Triangles (faces) should be identical, obverse to obverse and reverse to reverse if faces 

are mutually connected. The obverse and reverse surfaces of individual triangles (faces) 

comprise the obverse surface and reverse surface of a shell.  

 

 

◼ Regular Connection and Irregular Connection  

The normal shell connection is indicated in the left figure below where two faces are 

connected to each other with an edge in between. It is also indicated in the right figure 

below where faces are connected to each other around a vertex.  

 

 

 

  

Regular Connection
Two faces are connected 

with an edge in-between

Regular Connection
Faces are connected 

around the vertex
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An edge that resides on a shell boundary belongs to a single face. 

 

 

 

The figures below show irregular connections. 

A) 3 or more faces are connected to one edge. 

B) Multiple groups of mutually connected faces are connected to one vertex. 

 

 

 

Any irregular connections in a mesh may prevent normal command operations.  

This shape can be detected and corrected through the use of ‘Irregular Connection’ 

test item of the “Cleaning” command.  

 

The fact that two faces are connected to each other means that two faces share an 

edge including the vertices at the both ends of the edge.  

If the individual vertices of two edges do not meet mutually, the two edges are not 

connected with each other and have an extremely tiny gap in-between. In other words, 

the red line comprised of the two edges in the below figure has a hole.  

Regular Connection of Shell Boundaries

An edge belongs to a single face.

Shell 

Boundaries

A) B-1)

三つ以上のフェイスが接続するエッジ 複数の連結フェイス群と接続する頂点

B-2)

Edge where three or more faces 
meet

Vertices where multiple mutually-
connected faces meet  
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Such shapes can be detected and corrected by executing the ‘Gap’ test item, the ‘Hole’ 

test item of the “Cleaning” command, or the “Fill Holes” command. 
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2.2  Terms Used for Operation 

◼ Commands 

A command is a unit that a user executes functions. 

 

◼ Command Dialogue 

A Command Dialogue is a dialogue box that appears on the display upon activating a 

command. It is used to input parameters that are necessary for command execution 

and expressing execution results.  

 

◼ Detailed Parameters 

Detailed Parameters represent parameters that are used in order to explicate 

processing conditions among parameters that are input in the Command Dialogues. 

The field for Parameter Details is not displayed by default. Click an arrow icon [ ] to 

open the input field. Note that the arrow icon direction is changed depending upon 

the open status or the closed status. 

 

◼ Temporary Figures 

Temporary Figures are displayed only temporarily by the System in order to help 

user’s command inputs and display calculation results. Basically, they are green 

when users confirm their input directions, and they are red when they display the 

System calculation results.  

 

◼ Clip  

The “Clip” function hides figures that are positioned in the foreground of a plane. The 

plane specified is referred to as clipping plane, and can be transferred to arbitrary 

directions and positions. This function helps easy understandings of complicated 

structures by displaying internal side of solids.  
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◼ External Files 

There are several types of file formats such as STL, VRML, PLY, OBJ, OFF, NAS, 

BDF, and BLK. They are used in order to send and receive mesh data with other 

systems. 

 

◼ Result List 

Temporary Figures disappear when a command ends, but it is possible to save them 

using the Results List function until the System ends. Then, it is possible to switch 

display / non-display of saved Temporary Figures and automatically move the 

viewing state to the position where a Temporary Figure is present. 

 

◼ Shell List  

This is a list of shells displayed in Command Dialogues. 

 

◼ Box 

Box is a minimum-size cuboid containing a mesh with edges parallel to the coordinate 

axes. 

 

 

 
Temporary Figures Crip Box
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2.3  Color Terms 

Faces can have color data. Faces can have color data in the four ways below.  

 

 

 

■ Texture Coloring 

Triangular pieces of ‘Texture Image’ are assigned to faces. 

‘Texture Image’ has been imported into the System, where the image data is to be 

assigned to faces.  

 

■ Face Coloring 

A face is painted in a single color. This color is referred to as ‘Face Color’. 

 

■ Vertex Coloring 

Each vertex can have its ‘Vertex Color’.   

Blend colors of the three vertices of a face. Paint the face in the resulting blended 

color. Give gradation to the color composed of the three colors so that each of the 

member colors becomes intensified as it is closer to the corresponding vertex. 

 

■ No Colors 

Texture Coloring Face Coloring Vertex Coloring
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No color data is assigned. 

 

 

The face to which the texture is attached has information on the texture image to be 

pasted and the corresponding position (2D coordinates in the vertical direction and the 

horizontal direction) of a texture image for each vertex. Therefore, it is possible to paste 

areas of different texture images on adjacent faces. In addition, it is also possible to 

paste distant areas of the same texture image. As shown in the figure below, even 

though it seems that a pattern continuous to two adjacent faces is pasted, the area of 

the texture image to be referenced may be far away. 

A texture in which texture images are not continuous on both sides of an edge is called a 

‘Noncontiguous Texture’, and the non-continuous edge is called ‘Non-continuous 

Texture Boundary’. For non-continuous texture boundaries, restrictions are imposed on 

functions that change edges, such as simplification and remeshing, to keep the texture 

pattern. 

 
Mesh (3D shapes) Texture Images (2D)

Non-continuous Texture Boundary
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Noncontiguous Texture

Noncontiguous Texture

Mesh Texture Image

Refer

Refer
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3 Explanations of Screen  

This section explains the structure of screen and roles of individual portions. 

 

 

 

1. Application Button  

Click this button in order to display the window below where external files can be 

imported and exported.  

External files can be imported and exported by executing a relevant command in the 

‘File’ tab. Application Button enables their import and export without changing tabs. 
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2. File Name:  A name of file that has been imported is indicated. 

A file name may be illegible or positioned differently depending on the Style 

settings. (See ‘4. Style’ of this chapter.) 

 

3. Tab:  Click a tab in order to change contents of Command Selection Area. 

Chapter 5 of this manual provides an overview of the command functions for each 

tab.  

 

4. Style:  Command to change display styles such as window color schemes 

 

5. Command Selection Area 

Area where command-representing buttons are available for selection. 

If ‘▼’ appears under the name of button, click the inverted triangle in order to 

unfold and display folded commands.  
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Right-click on this area, or click the sign  of the ‘QAT’ area (See ‘6. QAT Area’ of 

this chapter.) in order to tick the ‘Minimize Ribbons’ option. Then, the Figure 

Display Area can be used widely by hiding the Command Selection Area. Left-click 

on the tab where the Command Selection Area is hidden, the Command Selection 

Area will be temporarily displayed. Follow the same operation as those followed in 

order to minimize the ribbons and untick the ‘Minimize Ribbons’ optional capability 

in order to resume the original display status. 

 

 

 

6. QAT (Quick Access Tool Bar) Area:  

This is an area where commands can be registered at the discretion of users. 

Register commands of frequent use in this area. Then, users will be able to select 

the commands from there without changing tabs. (See 4.3.8 ‘QAT Registration and 

Shortcut Keys’) 

 

7. Caption Bar: 

Unfold the folded 
commands.

Click the inverted triangle ▼.

Minimize
Ribbons 
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Area where messages (error messages, etc.)  from the System to users are 

displayed 

 

8. Information  

Information shows face quantity and vertex quantity of a mesh, and the directions 

of coordinate axes in the Figure Display Area. Coordinate values become larger the 

further away they are from the converging position of these three lines into the 

respective end of lines. 

Untick the ‘Information’ of ‘Details’ of the ‘Home’ tab in order to non-display them. 

 

9. Command Dialogue  

Area where necessary parameters for command execution are input, and execution 

results are indicated 

 

10. Figure Display Area 

Area where a 3D mesh shape is displayed 

 

11. Command Suspension Button  

Click the button in order to forcibly suspend a command execution. (See ‘4.3.5.  

Interim Progress Display and Process Suspension’.) 

 

12. Status Bar: 

This bar indicates a progress status of an executed command. 
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4 Explanation of Operation 

 

4.1  Activating and Exiting POLYGONALmeister 

 

■ Activating POLYGONALmeister 

Double-click the icon  of POLYGONALmeister on the desktop.  

POLYGONALmeister can also be activated by choosing Start | All Programs | 

POLYGONALmeister Folder | POLYGONALmeister. 

 

■ Exiting POLYGONALmeister 

Click the [X] button in the upper right corner of the screen in order to exit the 

software. Also, click the button  of the Application Button  at the upper left 

corner of the screen.  

 

  



20 

Copyright ©2022 UEL Corporation All Rights Reserved. 

4.2  Operation for Screen Display 

 

4.2.1  Viewing Operation  

The mouse operations below can scale up/down and move meshes in the Figure 

Display Area.  

-  Scale up/down by rotating the mouse wheel, or Page Up/Down. 

-  Translate by dragging the mouse with the wheel pressed, 

       or by dragging the mouse with the left side pressed. 

-  Perform a rotational transfer by dragging the mouse with the right side 

pressed. 

 

Right-click any point of a mesh. Then, the point becomes a new center for scaling 

up/down or performing a rotational transfer. A point in a mesh where the mouse begins 

to be dragged with the right side pressed becomes a center of rotational transfer.  

 

 

4.2.2  Clip 

This command disables figures if they are positioned in the foreground of a clipping 

plane.  

A clipping plane is a plane. Use this command in order to view parts that are difficult 

to see from outside such as the internal sides of solid figures.  

Select ‘Display’ of the ‘Home’ tab and tick the [Clip] check box. If a change is made in 

the viewing status partly due to a rotational transfer, the mesh and the clipping plane 

are moved together. 

Rotate the mouse wheel (or ‘PageUP/Down’ keys pressed) with the ‘Ctrl’ key pressed 

in order to move a clipping plane back and forth (in the direction perpendicular to the 

clipping plane). 
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Click the icon [Clipping Plane]  in order to change the direction of a clipping 

plane.  

The plane that is perpendicular to the present direction of gazing at the screen is set 

as the clipping plane. The clipping plane is deep in the direction towards a center of 

rotational transfer. Thus, right-click on the mesh before clicking the icon [Set Clipping 

Plane] in order to set a clipping surface that passes through the right-clicked position.  

 

 

 

 

4.2.3  Displaying Figures  

Meshes in the Figure Display Area can be displayed through the use of the [Face] 

button, [Wire] button or [Point] button. 

The [Clip] checkbox is unticked The [Clip] checkbox is ticked. And, rotate the mouse wheel 
with the ‘Ctrl’ key 

Click the icon 
[ Clipping Plane].

Right-click here.
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Faces have the observe surface and the reverse surface. The obverse surface is 

expressed in pale blue, and the reverse surface is expressed in dark blue.  

 

 

 

 

4.2.4  Initial Display and View in Parallel with Coordinate Axes 

Click the icon [Initial Display]  in order to display a view of an imported mesh. 

Click the icon [Initial Display] in order to display a pulldown menu below.  

The view of a mesh displayed by clicking the icon [Initial Display]  is the same 

view seen by selecting the option ‘Front (+X+Y)’, which is the view seen from the 

positive direction of Z axis.  

Face-ON, Edge-OFF, Vertex-OFF Face-ON, Edge-ON, Vertex-OFF Face-ON, Edge-OFF, Vertex-ON

Obverse surface

Reverse 
surface
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This view has two positive directions, the positive, horizontal X axis and the positive, 

vertical Y axis. A mesh cube comes to the center of the screen. ‘Up’ means viewing a 

mesh of the initial display status from the screen top (or the positive Y axis). The 

message ‘(-Z+X)’ next to ‘Up’ means that the view has the negative, horizontal Z axis’ 

and the positive, vertical X axis’. 

 

 

 

 

4.2.5  Mesh Comparison 

This function divides the Figure Display Area into two parts and displays the figure 

to be compared on the left and the current mesh on the right. 

When the [Mesh Comparison] check box is ticked, the command dialog for mesh 

comparison is displayed.  

If the ‘Before/After’ is selected, the mesh before processing (the state of ‘Undo’) will be 

displayed on the left. 

If the ‘External File’ is selected and the external file name is specified. The mesh of 

the external file is displayed on the left. 

 

X

Y

Z
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4.2.6  Information 

Tick the [Information] check box in order to display face quantity, vertex quantity and 

coordinate axes in the Figure Display Area. If the [Before/After] check box is ticked as 

well, face quantity, vertex quantity, and coordinate axes before operation and those 

after operation are displayed. 

 

 

4.2.7  Temporary Figure  

Tick or untick the [Temporary Figure] check box in order to enable 

display/non-display status of temporary figures such as for command operation results. 

Temporary figures are active only for a subject command. They will disappear if another 

command is selected. Use the “Result List” capability (See ‘4.3.6 Result List’ ) in order to 

save them.  

 

 

[Mesh Comparison] is unticked

The shape before processing
or

The shape in the external file

[Mesh Comparison] is ticked
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4.2.8  Color Display 

Tick/untick the [Color] check box in order to enable display/non-display status of color 

assigned to faces. 

 

 

4.2.9  Parallel Projection and Perspective Projection  

Tick or untick the [Parallel Projection] check box in order to select either of the figure 

display modes, parallel projection or one-point perspective projection. (Tick in order to 

select the mode of parallel projection. Untick in order to select the mode of perspective 

projection.) 

 

 

4.2.10  Grid 

When the [Grid] check box is checked, lines parallel to the X axis and lines parallel to 

the Y axis are displayed on the XY plane, and a red sphere indicating the position of the 

origin is displayed. 

 

 

 

4.2.11  Background 

The background (background color) can be changed by selecting Gradation, Black, 

White or Gray from ‘Background Color’ of ‘View Options’.  
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4.3  Operation for Screen Display  

 

4.3.1  Selection of Command 

Click a command icon in the Command Selection Area in order to activate it.  

Upon putting a mouse pointer on it, an explanation of command function is displayed.  

 

4.3.2  Command Dialogue 

If a command is activated, a command dialogue is open. Put a mouse pointer on  

of a command dialogue in order to display descriptions such as input items. Click 

the icon ‘Pin’  at the upper right corner of command dialogue in order to hide a 

command dialogue and save a broad space for Figure Display Area. (Note that the 

icon ‘Pin’ is displayed if a command dialogue is fixated at the edge of a window.) 

Click . Then, a command dialogue will disappear. This status means that no 

command is selected. 

 

A command dialogue can be transferred to a position in the Figure Display Area 

for an easy operation. Put a mouse pointer on the pale blue header at the top of 

command dialogue, and drag the mouse with the left button pressed in order to 

transfer the command dialogue. Drag the mouse till the command dialogue is over 

the icon  on the display in order to fixate the command dialogue at the edge of 

window. 
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Click a command dialogue and rotate a mouse wheel with the ‘Ctrl’ key pressed in 

order to scale up/down characters in a command dialogue. 

 

 

4.3.3  Inputting Parameters in a Command Dialogue 

Indicate parameters in a command dialogue through the use of text boxes, sliding 

bars, check boxes, and radio buttons as well as by operating figures in the Figure 

Display Area. (See ‘4.4 Operation of Figures’.) 

This section describes about inputting parameters in a command dialogue. 

Use  in the command dialogue of the “Cleaning” command in order to enable 

display/non-display status of an area where parameter details are input. Click  

and reverse the arrow direction upside down in order to display parameter details. 

Click it again in order to close the area where parameter details are input. 

There are parameter columns shown below that consist of a sliding bar and a text box. 

Users can use either a sliding bar or a text box. A value that is input in a text box is duly 

Original status Put a cursor on the header part of a command dialogue, 
and drag

Drag the command dialogue till the icon          is covered The command dialogue is fixated at the edge.
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reflected in the corresponding sliding bar, and vice versa. If a degree value is input, a 

sliding bar becomes purple accordingly. The right bottom parameter image shows 

example parameters for detecting acute-angled triangles. It indicates the detection of an 

acute-angled triangle that has an angle of 30 degrees or less and has a crease angle of 

60 degrees or more. 

 

 

 

A command dialogue is displayed in response to a selection of the command. 

Default values have been set for each parameter column in the command dialogue. 

If a mesh figure has been imported, default values are computed on the basis of the 

figure shape and set by the System. 

Values that are set in each parameter column will be recorded in the System once 

a command is executed. A recorded value is referred to as a ‘Previously Input Value’. 

It means that the ‘Previously Input Value’, not the ‘Default Value’ will be displayed 

if the command is selected again. Click a text box where a value is input in order to 

display a ‘Previously Input Value’ and a ‘Default Value’. (If a ‘Previously Input 

Value’ does not exist, a ‘Default Value’ alone is displayed.) 

Click ‘Default Value’ in order to replace a value in the text box with the ‘Default 

Value’. A ‘Previously Input Value’ will be saved till POLYGONALmeister is finished.  

 

 

4.3.4  UNDO/REDO 
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“Undo”  reverts a mesh to the status immediately before the latest editing 

operation (before executing the command that changes the shape). Note that the 

number of recoverable steps depends on the PC environment being used.  

“Redo”  cancels the “Undo” action, and displays a status after the latest 

operation. 

 

 

4.3.5  Interim Progress Display and Process Suspension 

Click the button [ x ] at the bottom right of the screen in order to suspend a processing 

during a command operation. Normally, a mesh will recover its previous status to the 

command operation. 

Note that there are some commands that prevent the button from being clicked. They 

are the “Import” command, the “Export” command, and other commands requiring a 

short processing duration. 

Tick the [Interim Progress Display] check box of the command dialogue of the 

“Smoothing/Feature Preserving” command, the “Simplify” command, or the “Remesh” 

command. Then, interim processing statuses are displayed by each phase, enabling 

processing statuses to be confirmed on a real-time basis. Tick the check box, ensuring 

that the [Pre-& Post-Operation Comparison] check box has been ticked. Then, 

processing progress can be easily understood through retroactive comparison.  

Click [ x ] during a command operation with the [Interim Progress Display] check box 

ticked, in order to record a mesh figure that is displayed when [ x ] is clicked as a result 

of command operation. Users can view a displayed mesh figure in order to confirm a 

sufficient processing. They can finish the command operation by clicking [ x ] if they 

thus judge.  

 

Ticking the [Interim Progress Display] check box is useful as indicated above. 

However, it takes a longer operation duration than an operation without the effect. 

Thus, untick the check box in order to shorten an operation duration. Note that a mesh 
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will recover its status previous to an operation if the operation is suspended with the 

[Interim Progress Display] check box being unticked.  

Click [ x ] while the “correction” optional capability of the “Cleaning” command is 

being executed. Then, a mesh that reflects corrections made before the click will be 

created. See the description of the “Cleaning” command for details.  

If the process is executed with the [Interim Progress Display] OFF, the processing 

time is shorter than ON. 

If [ x ] is clicked during the "cleaning" correction process, a mesh with the correction 

that has been completed up to that point will be created. 

 

 

4.3.6  Result List 

If problems of a mesh figure cannot be corrected automatically by the “Cleaning” 

command, users can save temporary figures of the problems that have been detected, 

and correct them by executing other commands. Also, they can view results of detecting 

cutting plane lines and creases when they execute other commands. 

Temporary figures disappear when other commands are selected. Use the “Result List” 

command in order to save temporary figures till the System is exited. 

Click the [Display Result List] button                 in a command dialogue in 

order to save temporary figures resulting from the command execution. Concurrently, 

the command dialogue [Display Result List] capable of managing saved temporary 

figures is displayed. Click the ‘Home’ tab | Operation | the [Display Result List] icon 

 in order to display the command dialogue.  

See below the example of a Result List. It shows that two self-intersections were not 

removed by executing the “Cleaning” command and have been left. Click the line 

‘Self-intersection’ of the “Result List” command. The first self-intersection is zoomed in 

automatically in the Figure Display Area in response. Click the right arrow  at the 

bottom of the Result List in order to zoom in the next self-intersection. Click the left 

arrow  in order to return to the first self-intersection.  
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The “Result List” command is a function capable of recording only one result for each 

test item. If the same test is conducted again, the first result will be overwritten.  

Temporary figures will be displayed if the item check box is ticked.  

Click the button [Delete Entire List] in order to delete all test results in memory.  

 

 

Click the line in order to focus back on 
the first temporary figure.

The next temporary figure is focused on.

The immediately previous temporary 
figure is focused on again.

This means that this is the 2 nd
temporary figure for the 5 th item.

A temporary figure will be displayed for 
an item that is ticked.。

Click this button in order to delete all 
items saved by the “Result List”.
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4.3.7  Shell List 

A Shell List is included in a command dialogue of commands that operate shells, the 

“Flip Shells” command, the “Delete Shells” command, and the “Export Shells” command. 

See the example below.  

Statuses of checkbox ( ‘□’), at the left end of each column, show whether selection or 

deselection has been made. 

Face quantity, surface area, and volume of each shell are indicated.  

If a negative volume value is indicated, the shell is reversed (which means, for example, 

that it is hollow inside). 

Note that 0 is indicated for an open shell volume. 

 

Click ‘Face Quantity’, ‘Surface’ or ‘Volume’ of the header in order to sort data with the 

clicked row as the key. 

Click again in order to replace an ascending order with a descending order, or vice 

versa.  

  Click  at the right side of the command dialogue in order to position a selected 

shell at the center of the screen. 

Click a column or a ‘ □ ‘ in order to tick the ‘ □ ‘. The ticked ‘ □ ‘ means that the item is 

selected for operation. A shell which is being selected is indicated through the use of 

green temporary figure in the Figure Display Area. Click a shell selected in the Figure 

Display Area in order to cancel the selection. Click the ‘ □ ‘ at the header in order to 

select all or deselect all.  
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34 

Copyright ©2022 UEL Corporation All Rights Reserved. 

 

4.3.8  QAT Registration and Shortcut Key 

Register commands of frequent use in QAT (Quick Access Toolbar) in order to 

improve operability for command selection. This section describes the method for 

registering commands in QAT. 

Click  at the right end of QAT in order to display a pulldown menu. Click ‘More 

Commands’ in the menu. 

 

 

The window below will be displayed. Change a tab in the left table of the window. 

Click a target command that needs to be registered. Click the button [Add] at the center 

in order to register the command in QAT. 

Click a command of QAT registration in the right table and change the order in QAT 

through the use of the right arrow buttons.  
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Shortcut keys can be assigned to commands.  

Click the [Customize] button at the bottom of the QAT registration window above. Then, 

the window below appears.  

Tab

Commands in the tab Commands registered in QAT

Buttons 
for Changing Order

Button for Registering Shortcut Keys

[Add] button
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The example above shows that the shortcut key ‘Ctrl+R’ is assigned for the ‘Import’ 

command. Select the ‘Import’ command in the tab ‘File’. Next, click the text box under 

the message ‘Press the key of assignment’. Press the key ‘R‘ with the key ‘Ctrl’  pressed. 

A message ‘undefined’ is displayed under the title ‘Assignment Destination’. This 

message means that the shortcut key ‘Ctrl+R’ has not been used. Click the [Assign] 

button and then the [Close] button.  

 

Note that the assignment of shortcut keys below has been already made by the 

System.  

Undo =  Ctrl + Z 

Redo ＝ Ctrl + Y   

Tab Commands in the tab

Input a key



37 

Copyright ©2022 UEL Corporation All Rights Reserved. 

4.4  Operation of Figures 

 

4.4.1  Specification of Figures  

Left-click on a target figure such as face, vertex, shell or hole in order to specify it. 

 

 

4.4.2  Specification of Areas 
This section describes the methods for specifying an area (where faces exist). They are 

the ‘Rectangular’ method, the ‘Free-Form’ method, the ‘Shell’ method, the ‘Color’ 

method, the ‘3D Sphere’ method, and ‘Auto’ method. They are applicable depending on 

commands that are used.  

 

■ Rectangular  

The method ‘Rectangular’ indicates faces in any rectangles where all sides lie in 

parallel with the screen frame. (Faces that are partially included in the rectangles are 

selected as well.).  

The method is also predicated on the specification of two diagonal points, a Drag Start 

Point and a Drag End Point.  

If an area indicated by dragging is composed of non-continuous faces, such faces that 

are therein connected to the faces closest to the user will be chosen.  

 

■ Free-Form 

The method ‘Free-Form’ selects faces that reside within an area delineated by a 

dragged path boundary. (Faces that are partially included in the areas are indicated as 

well.) 

A Drag Start Point and a Drag End Point are connected with a line segment.  

If an area indicated by dragging is composed of non-continuous faces, such faces that 

are therein connected to the faces closest to the user will be chosen. 

 

■ Shell 

The method ‘Shell’ enables an indication of area by clicking or dragging. Upon 

clicking a face, the shell which the face belongs to will become the target. Upon dragging, 

all shells that are minimally included in the area indicated by dragging will become the 

target.  
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Faces included in the target shells will be selected. 

 

■ Color  

The method ‘Color’ enables a selection of faces that are of the same color type as the 

clicked face.  

There are three types of color types according to how to hold the face color. 

- Faces that use the same Texture Image;  

- Faces that use the same Face Color (Note); 

- All faces where no color is assigned. 

 

For example, click a face which a Texture Image is assigned to. As a result, all the 

faces that use the same Texture Image are selected.  

 Faces with vertex colors cannot be used for color selection. 

 

 (Note)  

There are cases where monochrome faces that have the same RGB value may not 

assume the same Face Color. For example, faces are deemed to assume a different Face 

Color despite the same RGB value, if they belong to a separate shell that has been 

added.  

 

◼ 3D Sphere 

Drag a line on a mesh. The method ‘3D Sphere’ enables a selection of faces that are 

entirely included in the dragged corridor along which a sphere center travels. 

Put a mouse pointer on a mesh in order to display in blue, edges of faces that are 

included in the sphere. Begin dragging. More faces along the dragged corridor will be 

displayed in blue. Finish dragging in order to select an area of blue faces and display a 

temporary figure in green. Rotate the mouse wheel with the ‘Ctrl’ key pressed in order 

to change the sphere size.  
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◼ Auto 

The method ‘Auto’ enables a selection of faces that connects smoothly with the clicked 

face. 

 

 

Green temporary figures are displayed in order to indicate the chosen faces. 

Repeat the operation of area selection in order to add areas to the selected areas.  

Delete an indicated area from the selected areas by performing an area indication 

operation with the ‘Shift’ key pressed.  

Where the method ‘Rectangular’ and the method ‘Free-Form’ are concerned, click a 

face that has not been selected in order to add it to the area. Conversely, click a face 

that resides within the selected area in order to deselect that face.  

 

Click the [Back] button in order to cancel the previous operation of area selection, if 

the button is available.  



40 

Copyright ©2022 UEL Corporation All Rights Reserved. 

 

 

 

 

 

4.4.3  Drawing Auxiliary Lines 

Lines drawn by dragging the mouse is used in order to execute commands such as the 

“Cut” command and the “Divide Faces” command.  

The dragged 

portion is added 

to the area.

Drag the mouse 

in order to specify 

an area.

A temporary 

figure is 

displayed 

through the use 

of a temporary 

figure, upon 

finishing the drag 

operation.

Drag the mouse.

Drag the mouse with 

the [Shift] key pressed.

Drag the mouse 

with the [Shift] key 

pressed in order 

to remove the 

dragged portion 

from the area.

Click the faces marked with a red point.
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The methods of drawing lines are: ‘Line’; ‘Free-Line’; and ‘Polyline’. 

The method ‘Line’ enables a straight line that starts at a Drag Start Point and ends at 

a Drag End Point. The method ‘Free-Line’ uses a dragged path as a line. The method 

‘Polyline’ draws a polyline that connects clicked points. Double-click to end the Polyline. 

Drag the mouse with the ‘Shift’ key pressed in order to draw a horizontal or vertical line 

parallel to the screen framework when the method ‘Line’ and the method ‘Free-Line’ are 

used.  

 

 

 

 

4.4.4  Handle 

 ‘Handle’ is a tool capable of translating, performing rotational transfer, and 

scaling-up/down of image data of pictures, letters and shells.  

 

  The figure below is the handle used in the "Embed Relief" and "Stamp" command. 

Grab and drag the circle in order to perform a rotational transfer of characters, drawn 

lines or images. Grab and drag the bar in order to scale up or down a mesh in the 

dragging direction. 

Line Free-Line Polyline
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The figure below is a handle used with the "Drag Move" command. Grab the arrow 

and drag, the shell moves in the direction of the arrow. And grab the rectangular frame 

and drag, the shell moves on the plane on which the rectangular frame rides. 

 

 

State of transferring State of Scaling up/down

Move along the Arrow

Move on the Plane
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4.5  Operating Procedure 

Follow the editing procedure below in order to operate POLYGONALmeister.  

First, execute the “Cleaning” command in order to ‘test’ data after data import. 

Utilize the ‘Test’ optional capability in the command dialogue of the “Cleaning” 

command in order to check that a normal shape has been imported. Utilize the ‘Repair’ 

optional capability in order to correct if necessary. 

If there are problems of the shape that repel the correction by the “Cleaning” command, 

execute the “Defeature” command or the “Advanced Self-intersection Removal” 

command. Alternatively, delete faces of the issues, and fill the holes left behind the 

deletion. 

Execute the “Smoothing” command in order to delete minute surface roughness of 

measurement data. By using the "Reshape CT mesh" or "Reshape Optical Mesh" 

commands, cleaning and smoothing can be performed at once. 

Next, execute commands in order to edit mesh figures. Execute the “Cleaning” 

command if necessary in the midst of editing operation in order to confirm that mesh 

figures do not have problems if they have experienced significant changes (caused by 

executing the “Remesh” command, the “Cut” command, the “Wrapping” command, the 

“Thicken” command, or the “Offset” command). 

Reducing the number of faces with the “Simplify” command speeds up the operation, 

but results in a coarser mesh and some deviation from the mesh before simplifying. 

Therefore, it is better to simplify after performing the necessary editing operations.  

Finally, execute again the “Cleaning” command in order to confirm no problems with 

mesh shapes before exporting the data. 

 

POLYGONALmeister works best when the 3D size (diagonal length of the box) of the 

mesh is between 10 and 10,000. Therefore, meshes that are too small / too large for this 

size should be scaled to the above size immediately after importing (before executing 

other commands) with the "Scaling" command. Also, scale to the original size just before 

exporting. 
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  If the mesh is located far away from the origin, the calculation accuracy and display 

accuracy will be inferior, so it is recommended to move it to a position closer to the 

origin. You can easily move it by using “Move Box-center to Origin” of "Easy Layout" of 

the “Move / Copy” command. 

 

 

 

 

  

Activate POLYGONALmeister

Import

Cleaning

Smoothing

Command execution

Cleaning

Export

Exit POLYGONALmeister

Cleaning

Reshape CT mesh
Reshape Optical Mesh

Simplify
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5 Command Overview 

This chapter provides an overview of the functionality of the commands on each tab. 

 

Click the "How to use" button attached to each command to display a PDF file that 

describes the details of the function and the operation method. 
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5.1  File tab 

The “File” tab contains commands for inputting and outputting external files. 
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5.2  Home 

The “Home” tab includes the “Edit” Panel where frequently used commands capable of 

editing the mesh shapes are listed; the “Edit Shell” Panel where commands capable of 

editing shells are listed; and the “Transformation” Panel where commands capable of 

scaling up/down, transferring and copying are listed. The Create panel contains 

commands to create shells. 
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5.3  Edit  

In the "Edit" tab, there are commands to edit faces, edges, vertices, partial areas and 

the entire mesh. 
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5.4  Evaluation tab 

The “Evaluation” tab contains commands for measuring, evaluating, and inspecting 

meshes. 
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5.5  Colors  

The tab “Colors” includes commands for coloring meshes and editing the colors.  

In addition, there is a command to divide into segments (faces with the same face 

color) and edit them. 

See the ‘2.3 Color Terms’ about colors.  
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5.6  3D Print 

The tab “3D Print” includes commands to aid in preparatory work for molding with a 3D 

printer. 
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5.7  Geography  

The tab “Geography” includes commands to create a mesh from terrain and geographic 

data, and to evaluate the mesh, and to display GPS trajectory. 
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5.8  Relief  

The “Relief” tab includes commands capable of creating meshes out of images, and 

creating patterns on meshes through the use of images, letters and hand-written lines.   
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5.9  Beta Version 

The tab “Beta Version” includes test-version commands for reference.  
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5.10  Help 

The Help tab has commands for linking to the POLYGONALmeister website, 

browsing manuals, and managing licenses. 
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6 Precautions for operation 

⚫ Operation 

<Notes on the first startup of “CAD Surface Export”> 

Depending on your PC environment, the message "The file could not exported." May 

appear when you use the " CAD Surface Export " command for the first time. In that 

case, right-click the POLYGONALmeister icon and select "Run as administrator". From 

the second time onward, you do not need to do this operation. 
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 7   Settings 

 

7.1  System Requirements  

 

See below the necessary environment where POLYGONALmeister can operate.  

 

7.2  PC Settings Capable of Handling Polygons in 

Quantity 

Try the measures below if POLYGONALmeister cannot process a large quantity of 

polygons.  

 

1) Add memory to PC 

If your PC can accept additional memory, install the memory in order to enable it to 

process a larger quantity of polygons more effectively.  

Minimum Operational Specifications Recommended Specifications

Core i5 or higher Core i7 or higher （Xeon of 4 physical 
cores or more is recommended）

4GB or higher 16GB or higher

1GB or higher 2GB or higher

512KB or higher 1GB or higher

Intel Iris or higher NVIDIA Quadro / GeForce

Windows 8.1 （64-bit）
Windows 10  （64-bit）

1280 × 800 or higher TrueColor （32bit）

Internet Explorer 11 or higher,  OpenGL 3.3 or higher

CPU

Memory

Free Space on Drive

Video Memory

Video Card

Supported OS

Display Resolution

Others
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2) Create page file on SSD  

If an SSD has been installed in your PC, create a page file (swapping area) on the SSD 

in order to process a larger quantity of polygons without compromising speed. 

 

3) Create page file on HDD 

If an SSD has not been installed in your PC, create a page file on HDD in order to 

enable your PC to prioritize processing quantity over processing speed.  

 

[ Operating procedure on Windows 7, Windows 10 ] 

a) Select ‘System’ from ‘Control Panel’.  

b) Select ‘Advanced System Settings’ in the lest menu.  

c) Select ‘Settings’ of the ‘Performance’ section of the ‘Advanced Settings’ tab. 

d) Select ‘Change’ of the ‘Virtual Memory’ section of the tab ‘Advanced’. 

e) Untick ‘Automatically manage paging file size for all drives (A)’ if it has been ticked.  

Select the fastest SSD or HDD in the ‘Paging file size for each drive’ table. 

Select ‘Custom size’. Set ‘Initial size’ and ‘Maximum size’ to appropriate values. 

Click the button [Set], and click the button [OK]. 
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f)  Click "OK" button and restart Windows. 
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8   Limitations 

 

If the following conditions are met, POLYGONALmeister may terminate abnormally. 

 

■ Conditions 

⚫ If "Intel® Optane Pinning Explorer Extensions" is installed on your PC, 

POLYGONALmeister may terminate abnormally by operating in the following 

order. 

1.  Execute the command to display the temporary figure. 

2.  Perform an operation to display the file selection / save dialog. 

 

⚫ If your PC uses an NVIDIA graphics board, POLYGONALmeister may terminate 

abnormally by performing one of the following operations. 

・ Execute the “Display Enlarged Section Lines”. 

・ Perform “Display Section Lines”. 

・ Perform “Display Contour Lines”. 


